NVivo: 12Pro – Next Steps
Qualitative Data Analysis

Course objectives:
Making content into data
- Import media content
- Create a codebook
- Sets and Classifications
- Further exploration of data
- Visualisation tools

Student Training and Support
Phone: (07) 334 64312
Email: askus@library.uq.edu.au
Web: https://web.library.uq.edu.au/library-services/training/

Service Points
St Lucia: Main desk of the SSAH, ARMUS and DHESL libraries
Hospitals: Main desk of the PACE, Herston and Mater libraries
Gatton: Level 2, UQ Gatton Library

Staff Training (Bookings)
Phone: (07) 3365 2666
Email: staffdev@uq.edu.au
Web: http://www.uq.edu.au/staffdevelopment

Staff may contact their trainer with enquiries and feedback related to training content. Please contact Staff Development for booking enquiries or your local I.T. support for general technical enquiries.
# Table of Contents

**NVIVO: 12Pro** .............................................................................................................................................. 3

**Exercise 1.** Access NVIVO .......................................................................................................................... 3

**Getting Started** .......................................................................................................................................... 3

**Exercise 2.** Open a project ............................................................................................................................ 3

**Working with Data** .................................................................................................................................... 3

**Exercise 3.** Import Content .......................................................................................................................... 3

**Exercise 4.** Coding Sources ........................................................................................................................ 6

**Exercise 5.** View Image Coding ................................................................................................................ 7

**Exercise 6.** Create a new node .................................................................................................................... 7

**Exercise 7.** Create a Codebook ................................................................................................................ 8

**Exercise 8.** Import a Codebook .................................................................................................................. 9

**NCapture for web sources.** .................................................................................................................... 9

**Exercise 9.** Import content with NCapture .................................................................................................. 9

**Exercise 10.** Explore Imported Social Media Content ............................................................................... 12

**Exercise 11.** AutoCode NCapture import .................................................................................................. 13

**Exercise 12.** Explore Twitter Data ............................................................................................................ 14

**Exercise 13.** View Classification Sheets .................................................................................................. 15

**Sets** .......................................................................................................................................................... 17

**Exercise 14.** Create Sets for Analysis ....................................................................................................... 17

**Exercise 15.** Create a Matrix Coding Query using Sets ........................................................................... 18

**Classifications** ....................................................................................................................................... 19

**Exercise 16.** Import a classification sheet .................................................................................................. 20

**Querying Data** .......................................................................................................................................... 22

**Exercise 17.** Compound Query ................................................................................................................ 22

**Exercise 18.** Create a Coding Query .......................................................................................................... 23

**Visualisation Tools** .................................................................................................................................... 25

**Exercise 19.** Code Charting ...................................................................................................................... 25

**Exporting NVivo Data** .................................................................................................................................... 27

**Exercise 20.** Export Node References ...................................................................................................... 27

**Exercise 21.** Export a Node Summary ........................................................................................................ 28

**Exercise 22.** Export a Node Matrix ............................................................................................................. 28

**Reports and Extracts** .................................................................................................................................. 29

**Exercise 23.** Create a predefined report .................................................................................................... 29

**Exercise 24.** Create a predefined extract .................................................................................................. 30

**Extension Exercises** .................................................................................................................................... 31

**Exercise 25.** Add ‘case’ classifications ......................................................................................................... 31

**Exercise 26.** Add ‘source’ classifications ..................................................................................................... 32

**Exercise 27.** View Classification Sheet ..................................................................................................... 34

---

**Exercise files:** Go to [https://web.library.uq.edu.au/library-services/training/training-resources](https://web.library.uq.edu.au/library-services/training/training-resources)
**NVIVO: 12Pro**

NVIVO is designed to facilitate common qualitative techniques for organising, analysing and sharing data in a research project. NVivo can help you manage, explore and discover patterns in your data but it cannot replace your analytical expertise.

**Exercise 1. Access NVIVO**

1. Double-click the **Nvivo 12** icon on the Desktop

2. Complete profile details, if prompted
3. Add your initials. These will be used to identify your edits as you progress
4. Click on **OK**

**Getting Started**

**Exercise 2. Open a project**

A standalone project is a `.nvp` file saved on your computer or on a network drive.

1. Click the **File** tab
2. Click **Open**.

**Note:** Ensure **NVivo Projects** from the **File** or **Project type** list is displayed
3. Locate and select **UQLTraining-NextSteps** project
4. Click **Open**

**Working with Data**

**Exercise 3. Import Content**

a. **Bring in a PDF**

1. Select **Data - Files**
2. Click the **Import** tab
3. Click the **Files** button
4. Navigate to the **Other Data** folder
5. Double click **Sea Grant Fact Sheet.pdf**
6. Click on **OK**
7. Click on **Import** in the Import Files dialogue box
8. Click on **OK** in the Picture Properties dialog box when it appears

The PDF is added to the list of files

b. **Bring in images**

1. Select **Data – Files** in the navigator
2. Click the **Import** tab
3. Click the **Files** button
4. Navigate to the **Other Data** folder
5. Select **Barrier Islands and Cape Lookout.jpg**
6. Click on **Open**
7. Click on **OK**
8. Click on **Import** in the Import Files window
9. Click on **OK** in the Picture Properties dialog box when it appears

The image is added to the list of files

c. **Bring in Audio**

A video or audio source consists of a media file and a transcript. The transcript can be manually added, automatically created or purchased via NVivo and Transcribe.

1. Select **Data – Files - Interviews**
2. Click the **Import** tab
3. Click the **Files** button
4. Navigate to the **Media Data** folder
5. Select the **Helen.mp3** audio file
6. Click on **open**
7. Click on **Import** in the Import Files dialogue box

8. Go to the **Audio** tab in the Audio Properties dialog box
   Ensure Embedded in project is selected. This should be the default setting

9. Click on **OK**
   
   The audio file will be added to the list of Data - Files

**Transcribe audio for coding**

1. Double click the Helen audio file to open in details view
2. Click on **Click to edit**
   This will open the audio log for transcription beneath the file
3. Use the playback tools on the Audio Tools - Edit tab
4. Click to enter timespan
5. Add **0-10**
6. Click next cell to enter transcript
7. Add “**Interviewer Question**”

**Purchase a transcript using NVivo Transcription**

You can purchase a transcript from NVivo. As at February 2019 the cost per hour is $40 AUD with discounts for 5 and 10 hours. Turnaround is advertised as half the length of the audio. So a 1 hour file would take 30 minutes to be available. See [https://www.qsrinternational.com/nvivo/nvivo-products/transcription](https://www.qsrinternational.com/nvivo/nvivo-products/transcription) for full details of how to create an account and purchase credits.

**Import Transcript for coding**

1. Click the **Import** tab
2. Click the **Files** button
3. Select **Helen Transcript** in the Media Data folder
4. Click on **Open**
5. Click on **Import** in the Import Files dialog box
6. Click **OK**

### Exercise 4.  
**Coding Sources**

*a. Code documents*

1. Go to **Data - Files**
2. Double click **Helen transcript** to open the file in details view
3. Select “she doesn’t want to sacrifice the environment to gain affordable housing” on the first row of content
4. Right click on selected text
5. Select **Code**...
6. Hold Ctrl to select nodes
   - **Community Culture**
   - **Realestate Development**
   - **Natural Environment**
7. Click on **OK**
   
   Check the Node hierarchy, coding has been added to the appropriate nodes
8. Repeat for other transcript paragraphs

*b. Code PDFs*

Be careful with PDF’s. If the file has been created as an image coding specific content will not be possible.

1. Goto **Data - Files**
2. Open the PDF
3. Highlight the first paragraph
4. Navigate to **Nodes** to display Hierarchy
5. Expand **Natural Environment** if necessary
6. Drag and drop paragraph over **Water Quality** node
c. **Code Images**

1. Go to **Data - Files**
2. Open the image “Barrier islands and Cape Lookout”
3. Click and drag across the lighthouse in the image

4. Navigate to **Nodes** to display Hierarchy
5. Drag and drop selection over **Natural Environment** node

---

**Exercise 5. View Image Coding**

1. Go to **Nodes**
2. Double Click to node **Natural Environment** to open it
3. Click link to image **Barrier Islands and Cape Lookout**

The image coding reference will be pixel co-ordinates: starts at 330x270y and ends at 620x480y

4. The coded section will appear with shading

---

**Exercise 6. Create a new node**

1. Navigate to **Nodes**
2. Select **Node** on the **Create** tab

3. Enter a name - **Social Media**
4. Add a description – **NCapture Data**
5. Click on **OK**

The new node will be displayed in your node hierarchy.
**Codebook**

A codebook is a list of your thematic nodes and their descriptions that you can export from NVivo. You (or members in your team) can refer to the codebook to ensure consistency of coding.

**Exercise 7. Create a Codebook**

Ensure your nodes have a description before generating a codebook.

**a. Add Node Description**

1. Click **Properties** on the **Home** tab
2. Select **Node properties**...
3. Enter a description
4. Click on **OK**

**b. Generate Codebook**

1. On the **Share** tab click **Export Codebook**
   The Export Codebook dialog box displays.

2. Confirm a location for your codebook
   By default, the **Automatically select subfolders** check box is selected, so any subfolders will be included if you select or deselect a parent folder.

3. (Optional) Select **Include number of sources and references** check box.

4. Click **OK**.
   Note: Your codebook will display as an word document by default. Save the file to keep a permanent copy.

Alternatively: if you wish to share your codebook with other NVivo users or Qualitive data programs you must save it as a .qdc file type

5. In the Export Codebook dialog box click **Browse**...

6. Change the **Save as type:** to **Codebook Exchange Standard (*.qdc)** and click **Save**

7. Click **OK**
Exercise 8. **Import a Codebook**

To provide easy reference to the codebook for all researchers, it can be imported back into your project.

1. On the **Import** tab click **Codebook**
2. Select the **Codebook** document (*.qdc)
3. Click on **Open**
4. Click on **Import**

**NCapture for web sources.**

NCapture is a tool which allows users to capture web content including web pages, social media and video/audio clips.

Exercise 9. **Import content with NCapture**

To use the NCapture tool you have to first of all add the extension to your browser.

a. **Install NCapture extension to browser (Google chrome)**

1. Search in the browser **“NCapture Google Chrome”**
2. Click the link to the Google Web Store

Check the extension available is **offered by QSR International**

3. Click **“ADD TO CHROME”**

4. Click **Add extension**

A confirmation pop up may display. You can now capture web content for your NVivo project.

b. **Capture web content**

1. Navigate to a web source: [http://abc.net.au](http://abc.net.au)
2. Open any article
3. Click the NCapture icon on the addressline
4. Select Source type: **Article as PDF**
   This may not be successful with sites that contain dynamic data which automatically updates. You may need to use **WebPage as PDF** but be aware this will include all content including ads.

5. **OPTIONAL**: Add a description

6. **OPTIONAL**: Code at Node – **Social Media**
   Add Node names for auto coding (New or existing)

7. Click on **Capture**
   The article will be converted to a .nvcx file and the NCapture progress page will be displayed

C. **Capture Media Clip Content**

1. Navigate to youtube: [http://youtube.com](http://youtube.com)
2. Go to an appropriate media clip
   ![YouTube Media Clip](https://www.youtube.com/watch?v=DqDaZNyUKOg)
3. Click the NCapture icon on the addressline

4. Select Source type: **Video and Comments**
5. **OPTIONAL**: Add a description
6. **OPTIONAL**: Code at Node – **Social Media**
   Add Node names for auto coding (New or existing)
7. Click on **Capture**

Confirmation of the capture will be displayed

d. **Capture social media content**

1. Navigate to a twitter feed: [twitter.com/UQ_News](https://twitter.com/UQ_News)
2. Click the **NCapture** icon on the addressline
3. Select Source type: **Tweets are organised into a Dataset including Retweets**

4. **OPTIONAL:** Add a description

5. **OPTIONAL:** Code at Node – **Social Media**
   
   *Add Node names for auto coding (New or existing)*

6. Click on **Capture**

You may be asked to authorise NCapture to use your twitter account

7. Click on **Authorize app** or **Login**
   
   You’ll be returned to the twitter page.

8. Click on **Capture**
   
   This can capture up to 5000 tweets

   The article will be converted to a .nvcx file

e. **Import NCapture content**

1. Open **NVivo** project

2. Navigate to **Data - Files**

3. Click **Import Tab** and click **NCapture**

4. **Browse** to locate captures folders, if necessary
   
   Captures are usually located in the **Downloads** folder depending on the browser used.

5. Click **Selected Captures**

6. Select the captures to be imported

7. (Optional) Select Merging matching social media datasets
   
   This is the best way to bring in data captured over time

8. Click on the **Import** button

9. Navigate to **Data - Files**
   
   The imported content will be available.
Exercise 10.  

**Explore Imported Social Media Content**

**a. Display chart of social media content**

1. Navigate to Data - Files
2. Double click UQ News Twitter

3. Click the Chart tab at the right

4. Click Select Data on the Chart tab in the ribbon

5. Select Timeline by quarter for the X-axis
6. Select Number of references for the Y-axis

7. Double-click the chart series to see tweets

**b. Display cluster analysis**

1. Double click UQ News Twitter

2. Click the Cluster Analysis tab at the right

   A horizontal dendogram will display

3. Change to a 2D or 3D cluster on the ribbon
4. Double-click on any entry to view details
c. **Display map**

1. Go to UQ News Twitter

2. Click the **Map** tab at the right

3. Double click a pin to see tweets

4. Right-click on map

5. Select **Export Map...**

6. Choose a save type, location and file name

7. Click **Save**

---

**Exercise 11.**

---

**AutoCode NCapture import**

1. Navigate to **Data – Files** and select **UQ News Twitter**

2. Click **AutoCode** on the **ANALYZE** tab

3. **Confirm Code at nodes or cases for each value in predefined Twitter columns**

4. Click on **Next**
5. Select the **Username** and **Hashtag** options, if necessary
6. Click on **Next**

7. Enter a name for the Nodes – **Twitter Hashtags**
8. Enter a name for the Cases – **Twitter Handles**
9. Click on **Finish**
   
   This may take a little while depending on how many tweets you have.

**Exercise 12.**

**Explore Twitter Data**

a. **Nodes**

1. Navigate to **Codes - Nodes**
2. Expand **Twitter Hashtags**
3. Expand **Hashtags**
   
   This will let us see the hashtags used in the UQ_News twitter account.

4. Click the **References** heading to sort column
5. Double-click any **hashtag**

   You will see all tweets with the selected hashtag.

6. **Click Dataset** tab at the right

   This will display the dataset entry number with the tweet. Tweets captured will only be 280 characters this may cut off any automatic links or URL’s.

   Click a tweet link to navigate to source.
b. **Cases**

1. Navigate to **Cases - Cases**
2. Expand **Twitter Handles**
3. Expand **Usernames**
   
   This will let us see the most frequent users/references in the UQ_News twitter account

   1. Click the **References** heading to sort column (if required)
   2. Double-click any Twitter **Username**

   You will see all tweets with the hashtag selected

3. Click **Dataset** tab at the right
   
   This will display the dataset entry number with the tweet. Tweets captured will only be 280 characters this may cut off any links or URL’s

   Click a tweet link to navigate to source

---

**Exercise 13. View Classification Sheets**

a. **View classification structure**

1. Go to **Cases**
2. Select **Case Classifications**
3. Expand **Twitter User**

   A list of column headings or attributes for each user/case is displayed
a. View classification content values

4. Select **Home** tab click on **Case Classification**
5. Select **Twitter User**

The values of each attribute for each member is displayed. This can be changed via drop down lists attached to each cell
**Sets**

Sets are a flexible way of grouping your sources and nodes. Items in a set are references or 'shortcuts' to the original files. You can delete an item from a set without removing it from your project.

**Exercise 14. Create Sets for Analysis**

**a. Create Set**

1. Navigate to Search - Sets
2. Right-click on Sets folder
3. Select New Set

4. Add Long Term residents
5. Click on OK
6. Repeat for Incoming Residents

**b. Add members**

1. Right-click on set Long Term Residents
2. Select Add Set members...

3. Go to Cases
4. Expand interviewees
5. Select: Barbara, Dorothy, James, Margaret, Mary, Patricia, Richard, Robert and Susan
6. Click OK

All selected cases will be added to the appropriate set

Repeat for Incoming Residents

7. Select: Charles, Daniel, Maria, Thomas, William
Exercise 15. Create a Matrix Coding Query using Sets

Matrix coding query can easily compare coded material across different demographics or among themes. This can help you see patterns in your data and help you answer questions about your research. We can look at the intersect between sets and nodes.

a. Create a New Matrix from Sets

What we want to know is...

What do long term residents and newcomers say about Development Down East?

1. On the Explore tab click Query Wizard

The Query Wizard dialog box opens

2. Select Find coding intersections between two lists of items

3. Click Next

4. Click Add Selected Items...

5. In the Select Project Items window select Sets

6. Long Term residents and In coming residents will be selected

7. Click OK

8. Click Next

9. Click Add Selected Items....

10. Expand Nodes

11. Select Interview Questions

12. Click OK

Theme nodes represent coded text in the content

13. Click Next

14. Search in Files & Externals

15. Click Next

16. Add this Query to Project if you wish to rerun the query again after or Run this Query once if you only wish to use the query once
17. If you **Add this Query to Project** give the Query a Name and a Description (optional)

18. Click **Run**

19. You can run the query anytime from **Queries** in the Navigation view pane.

20. Double click **set matrix** result number to see content

b. **Viewing and amending matrix results**

   1. Click **Node Matrices** on the **View** tab
   2. Select **Words Coded**

The number of words coded by each gender for each question will be displayed.

3. Double click on any number result to see the coded references

**Classifications**

Coding allows you to organize your sources for later data analysis. Classifications are necessary to allow for further querying of data. They store information about your participants and sources. They provide a way to record descriptive information about the sources, nodes and relationships in your project. Think of this as a way of creating a database of imported content to help analyse it further. You can only have one classification applied to a node or source at any time.

These generally fall into 3 levels:  
- The **Classification**
- The **Attributes** within the classification
- The **Values** included in each attribute

Assigning cases and sources to classifications will allow you probe your data in a bit more depth.
Exercise 16. **Import a classification sheet**

NVivo associates your interview data with your attribute or demographic data through a case classification.

### a. Import Spreadsheet of demographic data

1. Navigate to **Cases – Case Classifications**
2. Right click in **List View**
3. Select **Import Classification Sheets...**
4. Click on **Browse...**
5. Select **Other Data folder - Interview Participants_Classification Sheet.xlsx**
6. Click **Open**
7. Click on **Next**

The key thing to this process is that NVivo will automatically recognize that you have a case node and associate all relevant information with the case provided that the name of the case node is exactly the same as the first cell in the spreadsheet.

Confirm **Classification type** is set to **Case Classification**.

8. Select the options:
   - *a. Create new attributes*
   - *b. Update the classification of existing sources or cases*
   - *c. Replace attribute values of existing sources or cases*
9. Click on **Next**

Confirm how the cases are represented

10. Select **As Names**
11. Click on **Select...**
12. Select **Cases\interviewees**
13. Select **Create new cases if they do not exist**
14. Click on **Next**

15. Confirm the **Date, Time and Numbers** formats
16. Click on **Finish**

The classification sheet will display.
b. **Apply cases to classification**

1. Navigate to **Cases - Cases**
2. Expand **Interviewees** (if necessary)
3. Select all **interviewees** cases
4. Right click on selection
5. Hover over **Classification**
6. Select classification: **person**

The data will be classified with attributes but will have no assigned values yet.

c. **Add/Edit attribute values**

1. Navigate to **Cases – Case Classifications**
2. Expand **Person** classification (if necessary) - Right-click **Age Range**
3. Select **Attribute Properties**...

4. Click the **Values** tab
5. Click the **Add** button
6. Enter **30-39**
7. Click the **Add** button
8. Enter **50-59**
9. Click the **Sort** button

10. Click the left side of the **not available** option
11. Click the **Remove** button
12. Click **OK**

If the removed attribute value is in use you will be prompted to select an alternative – If so select **Unassigned** – click **OK**

d. **Assign values to classification entries**

1. Assign a gender to each interviewee
2. Assign an age group to each interviewee
**Querying Data**

**Exercise 17. Compound Query**

Compound queries combine node and/or text searches. These can be used to check the thoroughness of project coding.

**a. Create a New compound query**

1. Select the **Explore** tab - Click **Compound**
   
   The Compound Query dialog box opens

2. Click the checkbox **Add to Project**

3. Enter a name **Text coding**

4. OPTIONAL enter a description

5. Click on the **Compound Criteria** tab

6. In Subquery 1 choose **Text Search Query**

7. Click on **Criteria...**

8. Enter text to search - **controlled**

9. Click **OK**

10. Change the query option to **AND NOT**

11. This will exclude the subsequent criteria

12. In subquery 2 choose **Coding Query**

13. Click on **Criteria...**
14. Select a particular Code or Case

15. Click select...

16. Select the Natural Habitat Node

17. Click on OK

18. Click on OK

19. Click the Query Options tab

20. Go to Spread Coding – Spread to - Broad Context

21. Click on Run (bottom left)

Results will be displayed
Tabs on the right allow results to be displayed as a Summary, by Reference, Text or Dataset

Exercise 18. **Create a Coding Query**

What we want to display is... *All the interviews which over 50 year olds reference the Economy*

1. On the Explore tab - Click Coding

2. Confirm Settings in the drop down boxes:
   
   **ANY of the following are true**

   *Coded at Any Selected Code or Case*

3. Click the Ellipsis button
4. Select **Economy** and its child nodes
5. Click on **OK**

6. Click the + symbol on the right to add another search criteria
7. Select **Any Case Where**
8. Click the ellipsis button

9. Expand **Survey respondent**
10. Select **Age**

11. Set the Age >=value
12. Set value to **50**

13. Click **Run Query**
Results may be displayed
14. Click **Save Results...** to keep a copy of results in the project
15. Click **Add to project...** to save the query settings

If no results appear it might mean no coding exists at this point in time. A message displays indicating there are no results. Change query settings or add coding before running query again.
**Visualisation Tools**

**Exercise 19.  Code Charting**

a. **Create a chart from node content**

1. Select Codes – Nodes
2. Click on any node
   e.g. Codes – Nodes – Interview Questions – Q.1. Connecto to Down East

3. On the Explore tab select Chart
4. Select Chart Node Coding

A chart will display reflecting a descending amount of coding for node content

b. **Create a coding chart from multiple nodes by attribute values**

What we want to chart is… *coding references in the interview questions by age group*

1. Select the 6 interview question nodes
2. On the Explore tab - click Chart
3. Select Chart Coding by Attribute Value
   Chart Options dialog box opens
4. Chart items – X-axis Attribute - Select
5. Expand Person
6. Select Age Range
7. Click on OK
8. X-axis attribute (below Chart items): **All attribute values except “Unassigned”, “Not Applicable”**

9. Y-axis: **Number of coding references**

10. **Click on OK**
    
    A chart will display showing the coding criteria requested. Use the chart tab on the Ribbon to change chart settings e.g Tye, Labes, Gridlines

**c. Hierarchy Chart**

A Hierarchy chart lets you visualise the coding associated with either nodes or sources or the values assigned to either cases or sources.

1. **Navigate to Codes - Nodes**

2. **Go to Interview Questions folder**

3. **Select all question nodes**

4. **On the Explore tab - Click Hierarchy Chart**

   **Hierarchy Chart wizard opens**

5. **Select Amount of coding for: Codes**

6. **Click Next**

7. **Compare: Select Items**

   **Click Select**

   **Expand Nodes**

   **Select all Interview Questions**

8. **Click OK**
9. Codes at: All Files, Externals & Memos
10. Click Finish

A hierarchy chart of coding is displayed

---

**Exporting NVivo Data**

**Exercise 20.**

`Export Node References`

Node References will export to a Word document as a default

1. Select the node to export in List View *(Natural Environment)*
2. On the Share tab Click Export
3. Select Reference View
4. (Optional) select the Browse button to change the name, location or format of the exported file
5. (Optional) Select the properties and related content that you want to include in the exported file.
6. (Optional) Select the Open on Export check box
7. Click OK

The exported references will open
Exercise 21.  
**Export a Node Summary**

A Node summary will export to an Excel spreadsheet as a default

1. Select the node to export in **List View**
   (Natural Environment)
   If you export a parent node with node aggregation turned on, the exported node includes content coded at the parent and content coded at all of the child nodes.
2. On the **Share** tab - Click **Export**

3. Select **Summary View**
4. (Optional) select the **Browse** button to change the name, location or format of the exported file
   Note: All the Include options are greyed out
5. (Optional) Select the **Open on Export** check box
6. Click **OK**

The exported summary will open

Exercise 22.  
**Export a Node Matrix**

A Node Matrix query will export results to an Excel spreadsheet as a default

1. Navigate to **Search - Queries**
2. Double click **Class Matrix** to run
3. Right click anywhere in the matrix
4. Select **Export Node Matrix**

5. Click on **Save**
   The matrix will be available as a spreadsheet.
Reports and Extracts
Reports contain information about your project that you can view and print. An extract allows you to export a collection of data for complementary analysis in other applications.

Exercise 23. Create a predefined report

a. Create a report

1. Navigate to Output - Reports
2. Select the Reports folder
3. Double click Code Summary Report
4. (Optional) Click a check box if you want to filter results
   a. Click Select to define filter criteria
5. Click on OK

The report is created and displayed in Details View. This includes a Report Map and thumbnails. Reports are dynamic and generated when run. To retain this information as a snapshot of progress you can export the results or create an extract.

b. Export a report

1. Right click on the report
2. Select Export Report Results
3. Navigate to a location for the extract to be saved
4. Choose Save as Type if you wish to use a file type other than Word
5. Click on Save
Exercise 24.  
Create a predefined extract

a. Create an extract

1. Navigate to Output - Extracts
2. Select the Extracts folder
3. Double click Coding Summary by Code Extract

4. (Optional) Click a check box if you want to filter results
   a. Click Select to define filter criteria
5. Click on OK

6. Navigate to a location for the extract to be saved
7. Change the file type to MS Excel (*.xlsx)
8. Click on Save

9. A success message will display on completion.

b. Open the extract in Excel

You may need to tidy up the extract before further analysis in Excel. All numbers brought across will be interpreted as text. This needs to be converted into numbers for reliable calculation

1. Navigate to Coding Summary by Code Extract.xlsx
2. Double click to open the spreadsheet
3. Select column J (Coverage)
4. Click Text to Columns on the Data tab

As only the cell content needs converted we do not need any other steps
5. Click on the Finish button

Ensure the column is still selected
6. On the Home tab click the Percentage button

**Extension Exercises**

**Further Classifications**

If you do not have a spreadsheet of demographic information you are able to create your own classification sheets and apply appropriate content to each case or source classification.

Exercise 25. **Add ‘case’ classifications**

a. **Create a CASE classification**

   *A case can only be in one classification at a time*

1. Navigate to Cases - CaseClassifications
2. Right click in List view
3. Select New classification

4. Add a name: Residents
5. Click on OK
b. **Add attributes and values**

1. Click on **Residents** classification
2. On the **Home** tab click **Case Classification** select **New Attribute**

3. Add an attribute name - **Age group**
4. Go to the **Values** tab
5. Click on the **Add** button
6. Enter **Over 50** attribute value
7. Click on the **Add** button
8. Repeat for **Under 50**
9. Click on **OK**
10. Repeat above to add a new attribute - **Gender**
11. Add the values **Male, Female, Non Binary**
12. Click **OK**

Exercise 26. **Add ‘File’ classifications**

a. Create a File classification:

   ![Image](image.png)

   **A File can only be in one classification at a time**

1. Navigate to **Data – File Classifications**
2. Go to **Create** tab - **File Classification**
3. Select **Add one or more predefined classifications to the project**
4. Click the checkboxes for the classifications to add:
   - Audiovisual Material,
   - Book
   - Electronic Article
   - Interview
   - Webpage
5. Click on **OK**

The new classification for File Classifications will appear.
b. **View File classifications; attributes**

1. Click on **Data - File Classification**
2. Select **Interview**
   - The interviewees will be listed under this classification

3. Click on the plus symbol
   - This will open the classifications to see attributes

**C. Modify attributes and values**

4. Double click on **Interviewer**

5. Click the **Values** tab
6. Click the **Add** button
7. Enter **Henry**
8. Repeat for **Nancy, Linda and Elizabeth**
9. Click the default checkbox alongside **Henry**
10. Click on **Apply**
11. Click on **OK**
   - If you choose to add values to a date and time attribute the format will be - **dd/mm/yy hrs:mins:secs am**

**d. Apply classification to Data**

1. Navigate to **Data - Files**
2. Go to **interviews**
3. Select all interviews
4. Right click on selected interviews
5. Hover over Classification
6. Select classification: **Interview**
Exercise 27.

1. Go to Data – File Classifications in Navigation view
2. Double click on interview
   The entries will be displayed with unassigned values

**e. Assign values to classification entries**

1. Click on an unassigned field
2. Select an appropriate value
   If all other entries have the same value copy and paste can be used to speed up the process.

3. Copy the first entry’s value (ctrl+C)
4. Select all other unassigned entries
   Click top entry, shift and click on last entry
5. Paste value (ctrl+V)